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Cadernos de geoprocessamento 10:  
Como proceder na detecção de 
mudanças de uso e cobertura da terra

Mapear os padrões de uso e cober-
tura da terra é essencial para o plane-
jamento e a execução de ações que en-
volvem a gestão do território. Quantificar 
e monitorar as mudanças de uso e 
cobertura da terra são elementos-chave 
amplamente reconhecidos pela comuni-
dade científica internacional no estudo 
de mudanças globais (Fearnside, 2001; 
Foley et al., 2005; Smith et al., 2014). 
Para a detecção de mudanças de uso e 
cobertura da terra, ao longo de um de-
terminado período, devem ser utilizados 
mapas referentes a duas ou mais oca-
siões e calculadas as diferenças entre 
eles, por meio de métodos pré-definidos.

Os dados de sensores orbitais são es-
pecialmente adequados para a geração 
de mapas e aplicação nos estudos de 
uso e cobertura da terra dadas às suas 

características de observação e monito-
ramento de forma sinóptica, dinâmica e 
em diferentes escalas espaço-temporais 
que possibilitam quantificar as taxas de 
conversão e mudança no uso e cobertu-
ra da terra (Turner II et al., 2007). 

Detectar mudanças no uso e co-
bertura da terra é um dos usos mais 
fundamentais e comuns da análise de 
imagens de sensoriamento remoto. 
Uma das formas mais rudimentares de 
detecção de mudanças é a comparação 
visual de duas imagens por um intérpre-
te treinado. Outra forma é gerar mapas 
de uso e cobertura da terra a partir da 
classificação de imagens que podem ser 
comparados, indicando mudanças em 
classes específicas, ao longo do tempo. 
Embora o conceito seja relativamente 
simples, na prática, há um grande núme-
ro de fatores que devem ser monitorados 
e controlados para alcançar resultados 
válidos de detecção de mudanças.

Wilson Anderson Holler, Engenheiro cartógrafo, especialista em Geoprocessamento, analista da Embrapa 
Florestas, Colombo, PR; Maria Augusta Doetzer Rosot, Engenheira florestal, doutora em Engenharia 
Florestal, pesquisadora da Embrapa Florestas, Colombo, PR; Luziane Franciscon, Estatística, mestre em 
Estatística e Experimentação Agronômica, analista da Embrapa Florestas, Colombo, PR; Marilice Cordeiro 
Garrastazú, Engenheira florestal, mestre em Engenharia Agrícola, pesquisadora da Embrapa Florestas, 
Colombo, PR; Yeda Maria Malheiros de Oliveira, Engenheira florestal, doutora em Ciências Florestais , 
pesquisadora da Embrapa Florestas, Colombo, PR; Jéssica Caroline Maran, Engenheira florestal, mestre 
em Engenharia Florestal, consultora FAO, Colombo, PR.
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Segundo Campbell e Wynne (2011), 
as imagens devem atender aos seguin-
tes critérios:

•	 Ser adquiridas a partir do mesmo 
sensor.

•	 Ser adquiridas à mesma hora do dia, 
usando o mesmo campo e ângulo de 
visão.

•	 Se obtidas em anos distintos, devem 
ser da mesma estação para minimizar 
diferenças devidas aos ciclos de vida 
das plantas.

•	 Ter precisão de registro com até dois 
décimos de um pixel ou menos;

•	 Ser livres de nuvens.
•	 Ter sido submetidas à correção de 

efeitos atmosféricos.

Tendo-se levado em conta tais requi-
sitos e estando disponíveis os mapas, ou 
arquivos vetoriais ou raster, com classes 
de uso e cobertura da terra, é possível, 
então, realizar a detecção de mudanças 
para a área de interesse. Neste docu-
mento são descritos procedimentos para 
executar a detecção de mudanças, em-
pregando-se ferramentas SIG tanto em 
software livre como proprietário. Foram 
utilizadas a extensão Land Change 
Modeler (LCM) (Clark Labs, 2017) para o 
ArcGis e Modules for Land Use Change 
Simulations (MOLUSCE) (2018) para o 
QGIS. Todos os procedimentos descri-
tos foram testados e validados. Tanto 
o LCM quanto o MOLUSCE, possuem 
mais recursos que os descritos neste 
documento, ampliando as possibilidades 
de outras análises como a geração de 
cenários de alteração de mudanças.

•	 Para exemplificar os procedimentos, 
foram utilizados os mapas de uso e 
cobertura da terra de duas Unidades 
Amostrais de Paisagem (UAPs) do 
Inventário Florestal Nacional do Brasil 
(IFN-BR) (Freitas et al., 2016). A gera-
ção dos mapas de uso e cobertura das 
duas UAPs seguiu as diretrizes publi-
cadas em Luz et al. (2018a, 2018b).

Dessa forma, estudos que tenham 
como resultado um mapa de uso e co-
bertura da terra podem ser beneficiados 
com os procedimentos descritos nesse 
documento, ampliando seu alcance 
e otimizando o uso de resultados já 
existentes.

Materiais

Para a detecção de mudanças de uso 
e cobertura da terra foram empregados 
os seguintes programas:

•	 QGIS Desktop 2.18.18 (QGIS, 2018): 
O QGIS é um Sistema de Informação 
Geográfica (SIG) de Código Aberto 
licenciado segundo a Licença Pública 
Geral (GNU).

•	Modules for Land Use Change 
Simulations (MOLUSCE) (2018): 
extensão do QGIS para avaliação de 
mudanças no uso da terra.

•	 ArcGis Desktop (versão 10.5) (ESRI, 
2017): edição de dados vetoriais e 
matriciais. Foi utilizado para a reclas-
sificação dos dados raster e uso do 
LCM.
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Procedimentos para a 
detecção de mudanças de uso 
e cobertura da terra usando 
o QGIS com a extensão 
Modules for Land Use Change 
Evaluation (MOLUSCE)

O MOLUSCE é uma extensão, dis-
ponível para o QGIS 2.0 e versões su-
periores (Modules for Land Use Change 
Simulations, 2018). Foi projetado para 
analisar, modelar e simular mudanças 
de uso e cobertura da terra. Incorpora 
algoritmos conhecidos, que podem ser 
usados para:

•	 Analisar o uso e cobertura da terra 
e suas mudanças entre diferentes 
períodos de tempo.

•	 Modelar o uso e cobertura da terra e 
potencial de transição.

•	 Simular futuras mudanças de uso e 
cobertura da terra.

O MOLUSCE possui seis módu-
los: Entrada, Avaliação de correlação, 
Análise de mudança de área, Métodos 
de modelagem, Simulação e Validação. 
Neste trabalho são abordados somente 
os três primeiros módulos:

•	 Land Change Modeler (LCM), modela-
dor de mudanças no uso da terra (ver-
são 2.0) (Clark Labs, 2017): extensão 
para o software ArcGis. Empregado 
para mapear as mudanças na paisa-
gem, identificar transições de classes 
e tendências.

As duas extensões requerem arqui-
vos no formato raster geotiff igualmente 
recortados, com o mesmo sistema de 
referência e de projeção, e de mesma 
resolução espacial, pois, caso contrá-
rio aparecerá uma mensagem de erro. 
Assim, é necessário preparar os dados 
cuidadosamente seguindo, basicamen-
te, três etapas:

•	 Preparar dados para fazer análise.
•	 Carregar dados para análise.
•	 Gerar matriz de transição usando a 

extensão.

As instruções a seguir descrevem, 
para as duas extensões, como criar 
uma matriz de transição para detectar 
mudanças de uso e cobertura da terra 
de uma Unidade Amostral de Paisagem 
(UAP) (Luz et al., 2018a).

Métodos

O LCM usa matrizes da cadeia de 
Markov para determinar a quantidade 
de mudança e mostrar espacialmente 
essas mudanças. Uma aplicação de-
talhada dessa abordagem pode ser 

encontrada em Paegelow e Camacho 
Olmedo (2005). A extensão MOLUSCE 
permite a geração de matrizes de transi-
ção, também utilizando uma abordagem 
Markoviana (Rahman et al., 2017).
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•	 Módulo de entrada (Input):

-- 	Mapas de uso e cobertura da terra 
de diferentes épocas, dados biofísi-
cos e socioeconômicos como rede 
rodoviária, rios, topografia, popula-
ção, etc., em formato raster, podem 
ser carregados neste módulo.

•	 Avaliação de correlação (Evaluating 
correlation):

-- Este módulo dispõe de técnicas para 
realizar a análise de correlação entre 
dois arquivos raster, com o uso e co-
bertura da terra de diferentes épocas.

•	 Análise de mudança de área (Area 
change analysis):

-- Calcula as alterações de uso e co-
bertura da terra entre dois períodos 
de tempo (T0 e T1). Tem como resul-
tado as matrizes de transição de uso 
e cobertura, bem como os mapas 
de mudança de uso e cobertura da 
terra.

Como criar uma matriz de 
transição para detecção de 
mudança de uso e cobertura 
da terra no software QGIS

Para este procedimento requer-se os 
seguintes materiais:

•	 QGIS Las Palmas 2.18.18 com a ex-
tensão MOLUSCE.

•	 Shapefile com o uso e cobertura da 
terra para dois diferentes anos (2011 e 
2014) da mesma UAP.

Primeiramente, usando o Windows 
Explorer, deve-se:

•	 Criar uma Pasta com o nome da UAP, 
Figura 1:
-- UAPXXXX.

Figura 1. Estrutura das 
pastas de trabalho.

•	 Criar duas subpastas dentro dessa 
pasta, sendo uma para cada ano 
(Figura 1).

•	 Inserir os arquivos vetoriais (shapefile) 
de cada ano na pasta correspondente.

•	 Depois de inseridos os arquivos 
shapefile, renomeá-los para que te-
nham, no final de seu nome, o ano 
“UAPXXXX_LULC_2011”.

Os procedimentos descritos na 
sequência demonstram como realizar 
a detecção de mudanças no QGIS 
utilizando a extensão MOLUSCE. É 
importante que o campo NDV (No Data 
Value) esteja marcado em cada camada 
adicionada ao QGIS. Se isto não ocorrer, 
o MOLUSCE processará as áreas sem 
valor de dados como classes de uso ou 
ocupação do solo, aumentando o tempo 
de processamento e prejudicando a 
calibração do modelo. O MOLUSCE 
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adiciona o NDV da camada base de 
entrada e o propaga a cada mapa de 
saída, juntamente com a geometria da 
camada base (Modules for Land Use 
Change Simulations, 2018).

Os seguintes procedimentos são 
executados em ambiente QGIS:

•	 Criar um projeto e salvá-lo na pasta da 
UAP correspondente.

•	 Conferir o sistema de referência e 
de projeção, sendo recomendada a 
Projeção Equivalente de Albers, com 
os seguintes parâmetros:
-- Longitude de origem -54° e Latitude 
de origem -12°, Paralelo padrão 1: -2° 
e Paralelo padrão 2: -22°. A unidade 
de medida utilizada para o cálculo 
de áreas foi km2. Para as extensões 
recomenda-se o sistema de projeção 
Policônica, tendo como parâmetros 
de origem a latitude 0° e a longitude 
-54° e unidade de medida km.

•	 Padronizar as colunas das tabelas, 
mantendo somente duas colunas 
“LULCAno” e “Area”:
-- Habilitar o modo edição.
-- Criar a coluna “LULCAno”.
-- Atribuir à nova coluna os valores da 
coluna “LULC”.

-- Excluir outros campos para deixar 
somente os campos “LULCAno” e 
“Area”.

-- Salvar (Gravar) as alterações.
•	 Converter o Shapefile para Raster 

(Geotiff).
•	 Padronizar legenda.

Para realizar a análise é neces-
sário, primeiramente, preparar os 

dados de acordo com os seguintes 
procedimentos:

•	 Recortar o conjunto de dados para os 
limites estabelecidos para a região de 
estudo. Se estiver sendo usada uma 
área pré-definida que já possua os 
arquivos shapefile de uso e cobertura 
da terra, pode-se ignorar esta etapa 
e seguem os passos seguintes para 
rasterizá-los.

•	 Selecionar a ferramenta Clipper em: 
Raster > Extração > Clipper.

•	 Selecionar o arquivo raster que se 
deseja recortar.

•	 Clicar em Selecionar para abrir a 
janela de navegação e navegar até o 
local onde se deseja salvar o arquivo, 
nomeando-o e clicando em salvar.

•	 Verificar a camada de máscara e sele-
cionar/escolher o shapefile para fazer 
a análise.

•	 Verificar a opção recortar para recortar 
o arquivo para a forma do arquivo 
shapefile (Opcional).

•	 Verificar a resolução do arquivo de 
saída, digitando o tamanho do pixel 
desejado em unidades de mapa.

•	 Clicar em OK para salvar o arquivo 
geotiff.

A Figura 2 apresenta os passos 
para a conversão de arquivo vetorial 
para raster, numerados em sequência, 
conforme a descrição a seguir:

1)	Selecionar a ferramenta Vetor para 
Raster (rasterizar) em: Raster> 
Converter > Vetor para Raster 
(rasterizar).
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Figura 2. Conversão de vetor para raster.

2) Selecionar o arquivo de entrada 
(shapefi	le) “UAPXXX_LULC_ANNO” 
para rasterizar.

3) Selecionar o campo a ser usado para 
atribuir cada valor de pixel: LULC2014, 
campo numérico (número inteiro).

4) Clicar no botão de Selecione, na 
frente do campo de saída, para abrir 
a janela de navegação.

5) Navegar até o local onde se dese-
ja salvar o arquivo, nomeando-o 

(UAPXXX_LULC_ANNO) e clicar em 
Salvar.

6) Digitar o tamanho do pixel desejado 
em unidades de mapa para o arquivo 
de saída. Por padrão defi nir 1.

7) Clicar em OK para salvar o arquivo 
geotiff	.

Depois de adicionar os arquivos 
raster é necessário defi nir o estilo e 
rótulo do conjunto de dados, conforme 
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procedimentos numerados em sequên-
cia na Figura 4 e descritos a seguir: 

1. Clicar com o botão direito na camada 
e selecionar propriedades.

2. Na seção Estilo > Renderização da 
banda, selecionar Banda simples 
falsa-cor.

3. Carregar valores mínimo e máximo, 
selecionar Min / Máx e clicar no botão 
Carregar.

4. Defi nir as classes, cobrindo todos 
os valores de pixels no conjunto de 
dados e, em seguida, rotular todas as 
classes (no exemplo são 10 classes 
mostradas na Figura 3). O rótulo 

será utilizado para gerar a matriz de 
transição. Somente irão aparecer as 
classes existentes na camada; as 
outras devem ser deixadas no tom de 
cor preto para facilitar a identifi cação, 

Figura 3. Rotulagem das classes.

Figura 4. Defi nição do estilo e rótulo do conjunto de dados.
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se eventualmente aparecerem. Para 
acrescentar mais classes deve-se 
selecionar o Modo > Intervalo Igual 
e adicionar Classes até o total de 
classes existentes no mapa de uso 
e cobertura da terra. Esse procedi-
mento apenas precisa ser executado 
para um dos anos de observação, 
devendo-se salvar o modelo de le-
genda para ser utilizado no mapa de 
outro ano.

5.	 Clicar em Aplicar e, em seguida, em 
OK, para fechar esta janela. 

A Figura 5 apresenta os passos 
para a inserção dos dados na extensão 
MOLUSCE, numerados em sequência e 
descritos a seguir:

1.	 Abrir a extensão MOLUSCE cli-
cando em Raster > MOLUSCE > 
MOLUSCE.

2.	 Selecionar o arquivo raster, com as 
classes de uso e cobertura da terra, 
do ano mais antigo (2011) como 
Initial e o arquivo raster mais atual 
(2014) como opção Final.

Figura 5. Inserção dos dados na extensão MOLUSCE.
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3. Mesmo o arquivo de variável espa-
cial não sendo necessário para esta 
análise, é necessário indicá-lo. No 
exemplo foram utilizados os próprios 
arquivos raster com o uso e cobertu-
ra de cada ano;

4. Clicar em Check Geometry e, caso 
a geometria coincidir, pode-se pros-
seguir para a análise. Se ocorrer 
algum erro, será necessário revisar 
os arquivos raster e padronizá-los 
em relação à sua extensão, sistemas 
de projeção e referência, legenda e 
resolução espacial.

O módulo de avaliação de correlação 
contém três técnicas para a execução 
da análise de correlação: i) Correlação 
de Pearson; ii) Coefi ciente de Cramer; 
e iii) Incerteza de informação conjunta. 

O usuário pode escolher realizar uma 
comparação entre dois arquivos raster, 
selecionando o primeiro e o segundo 
raster, ou entre todos os raster carre-
gados no MOLUSCE. Pode-se executar 
a correlação, pressionando o coman-
do Verifi cação (Check) localizado na 
parte inferior da janela. As técnicas do 
Coefi ciente de Cramer e de Incerteza de 
informação conjunta trabalham apenas 
com dados categóricos. Nesse caso, os 
dados devem ser categorizados previa-
mente (por ex. com o uso do GRASS).

Na etapa da geração da matriz de 
transição propriamente dita, as classes 
devem ser iguais, ou seja, a nomencla-
tura e número de classes devem ser as 
mesmas. Caso alguma classe apareça 
em somente uma das datas, o proces-
samento não será realizado. A Figura 6 

Figura 6. Matriz de transição.
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apresenta os passos para gerar a matriz 
de transição.

1.	 Selecionar a guia Area Changes na 
extensão MOLUSCE.

2.	 Selecionar a unidade pré-definida no 
menu de opções da unidade.

3.	 Clicar em Update tables para carre-
gar a matriz de transição.

4.	 Clicar com o botão direito do mouse 
na matriz e pressionar CTRL + C 
para copiar os dados. Pode-se colar 
os dados em uma planilha eletrônica 
como o Excel, OpenOffice ou Google 
Sheets.

5.	 Clicar no botão Create changes map 
para criar o mapa de transição. Essa 
nova camada será adicionada auto-
maticamente ao QGIS e deverá ser 
salva como GeoTiff.

Procedimentos para a 
detecção de mudanças de uso 
e cobertura da terra usando 
ArcGis com a extensão Land 
Change Modeler (LCM)

O LCM usa como dados de entrada 
do modelo, dois mapas de uso e cober-
tura da terra que, no presente trabalho, 
correspondem aos anos de 2011 e 2014. 
A extensão LCM calcula as superfícies 
correspondentes às áreas onde houve 
mudança de classe, identificando quais 
as transições ocorridas, tanto em termos 
absolutos como percentuais.

Inicialmente, é necessário prepa-
rar os dados para realizar a análise, 

padronizando-os em relação à sua ex-
tensão, sistemas de projeção e referên-
cia, legenda e resolução espacial. Para 
todos esses procedimentos será ne-
cessário dispor da licença da extensão 
Spatial Analyst do Arcgis. Os arquivos 
raster também devem ser reclassifica-
dos para uma numeração sequencial, 
iniciando com um número diferente de 
zero, conforme procedimentos numera-
dos em sequência, descritos a seguir e 
mostrados nas Figuras 7 (passos 1 a 4), 
8 (passos 5 e 6) e 9 (passos 7 a 10), 
respectivamente: 

1.	 Acessar o menu Spatial Analyst 
Tools.

2.	 Acessar a opção Reclass.
3.	 Selecionar Reclassify.
4.	 Entrar com os valores Old values e 

New Values, correspondentes às co-
lunas Original e Alterado, mostradas 
na Tabela 1.

5.	 Clicar com botão direito do mou-
se sobre a camada e ir em Open 
Attribute Table.

6.	 Adicionar campo class_name com o 
nome curto das classes (siglas).

7.	 Depois de criada a coluna, habi-
litar o modo edição para inserir o 
nome, ou sigla, das classes. Ir em 
Data Management Tools > Raster  
> Raster Dataset > Copy Raster, 
realizando a exportação com essa 
ferramenta.

8.	 A configuração deve ser: NoData 
Value = 255.

9.	 Preencher Pixel Type = 
8_BIT_UNSIGNED.

10.	Preencher Format = TIFF.
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Figura 7. Reclassifi cação da numeração das classes no programa ArcGIS.

Figura 8. Procedimentos para adicionar campo à tabela no programa ArcGIS.
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Figura 9. Procedimentos para salvar em formato raster no programa ArcGIS.

Tabela 1. Exemplo de como reclassificar a numeração das classes no 
ArcMap.

Classe Original Alterado
Área não Observada (ANO) 0 0
Floresta Natural (FN) 1 1
Outras Terras com Árvores (OTA) 3 2
Gramíneas e Herbáceas (GH) 4 3
Floresta Plantada (FP) 5 4
Solo Exposto (SE) 6 5
Agricultura e Pastagem (AP) 7 6
Influência Urbana (IU) 8 7
Superfície com Água (SA) 9 8
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Figura 10. Inserção dos arquivos raster na extensão LCM do programa ArcGIS.

A Tabela 1 segue a codifi cação 
Original, apresentada em Luz et al. 
(2018, p. 60).

Os procedimentos para carregar 
os dados para análise são mostrados 
na Figura 10, sendo numerados em 
sequência e descritos a seguir:

11. Depois de os dados estarem padro-
nizados, inseri-los no LCM.

12. Clicar em Continue....

13. A aba Change Analysis fi cará em 
evidência.

Durante a execução, a extensão 
LCM pode apresentar os seguintes avi-
sos, mostrados na Figura 11:

• As áreas de segundo plano não cor-
respondem ou o código de segundo 
plano não é 0 (zero).

• Categorias de legenda não coincidem.

 

Figura 11. Avisos do LCM. 
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•	 IDs (Identity - Identificação) de catego-
ria são números sequenciais.

•	 O ID da categoria de legenda não 
pode ser 0 (zero).

Se isso ocorrer com os dados o LCM 
abrirá uma tela onde é possível configu-
rar as legendas e valores das classes do 
arquivo raster.

No LCM, mesmo que não exista 
alguma classe em uma das datas, é 
possível padronizar as legendas. Para 
isso, basta inserir a legenda da classe 
inexistente na data na qual não aparece, 
somente como um artifício para fins de 
processamento no LCM. Na extensão 
LCM é necessário que os números 
de classes, assim como as legendas, 
estejam presentes nas duas datas, 
mesmo que em uma determinada data 

não seja encontrada uma determinada 
classe.

Depois de padronizadas as legendas 
o LCM calcula as alterações das classes 
ocorridas. A Figura 12 (passo 14 da aná-
lise de mudanças no LCM) apresenta a 
interface Change Analysis.

 Para salvar os Mapas de Mudanças 
(Change Maps), devem ser observados 
os procedimentos mostrados na Figura 
13, numerados em sequência e descri-
tos a seguir:

14.	Inserir um nome em Output name.
15.	Clicar em Create Map.

 
Como resultado dos procedimentos 

será gerada uma nova camada raster 
com as alterações do tipo “de-para”, 
conforme mostrado na Figura 14.

Figura 12. Janela da Análise de 
mudança na extensão LCM. 
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Figura 13. Geração do mapa de mudanças com a extensão LCM do programa ArcGIS.

 

 

Figura 14. Janela do programa ArcGIS mostrando a representação raster da detecção de 
mudanças gerada com a extensão LCM
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ADHIKARI, A.; SOUTHWORTH, J. Simulating 
forest cover changes of Bannerghatta National 
Park based on a CA-Markov model: a remote 

Considerações finais

Os resultados de uma análise de 
detecção de mudança fornecem subsí-
dios para apoiar o planejamento estra-
tégico de diretrizes que contemplem a 
gestão do território ao longo do tempo, 
especialmente o rural. Os procedimen-
tos descritos podem ser replicados em 
outros trabalhos, desde que observada 
a sequência indicada. As extensões 
LCM e MOLUSCE podem ser utilizadas 
também para a geração de possíveis 
cenários de alteração do uso e cobertu-
ra da terra. O MOLUSCE já foi utilizado 
nos trabalhos de Habel et al. (2018), 
Requena-Mullor et al. (2017) e Rahman 
et al. (2017), para avaliar a dinâmica 
temporal da mudança do uso e cobertu-
ra da terra e previsão de alterações das 
classes. O LCM já foi aplicado para de-
tectar mudanças e análise de tendências 
de alteração de uso e cobertura da terra 
(Václavik; Rogan, 2009; Holler, 2018), 
desmatamento tropical (Koi; Murayama, 
2010), crescimento urbano (Aguejdad; 
Houet, 2008), erosão sob diferentes 
cenários de conservação (Gaspari et al., 
2009) e modelagem de habitat (Gontier 
et al., 2009). Outros exemplos de aplica-
ção do LCM podem ser encontrados em 
Mobaied et al. (2011), Sang et al. (2011) 
e Adhikari e Southworth (2012).
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